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Introduction 

What is Travel Training?  

The ability to travel at will within their community enriches peoples’ 

lives by giving them access to recreational facilities, social 

interaction, health and business services, and all the other activities 

that are part of a full and independent life.  Public transit is one way 

that people can achieve this independent mobility.  But many people 

are, for various reasons, reluctant to use public transit.  Today’s 

public transit systems are becoming increasingly customer-friendly 

and accessible and are able to serve a broader segment of the 

population. 

Travel training teaches people who have not previously used public 

transit to travel safely and independently within the community by 

using their local transit system.  Through travel training people can 

develop the skills necessary to travel with flexibility and self-reliance 

within the community.  Travel training is particularly helpful for 

introducing public transit to people with disabilities, newcomers to 

Canada, youth or older adults who are hesitant to try taking transit on 

their own. 

Description of Travel Training 

Travel training is best delivered to people in a familiar setting.  It is 

typically provided through a community organization or facility to the 

clients of that organization.  Travel training may be delivered: to 

senior citizens in their residences or community centres, to youth 

through community programs, and to people with disabilities through 

social service organizations.  Training may be delivered by an agency 

professional or by a volunteer – perhaps a peer of the participants.      
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Training can be provided in a group setting, or as one-on-one 

instruction, and can be adapted to suit individual needs.  Training for 

seniors who know their community but are learning to travel without a 

car is very different from training for individuals who have not been 

able to leave home independently due to a disabling condition of 

some sort.  

The materials required in a community for travel training must reflect 

the specific public transit characteristics of that community, and are 

typically prepared by the local transit agency for use by the 

community trainers.  The materials must accurately and effectively 

explain the service, fares, accessibility, policies and other aspects of 

the specific transit system, in addition to more general information 

about using transit and, where required, the specific trip that a person 

wants to be able to make.  

Who benefits from Travel Training? 

For the individual, travel training can provide the freedom and 

confidence to travel independently through the community.  

Individuals with disabilities, seniors, newcomers to Canada, families, 

and youth who are not confident travelling on transit may benefit from 

participating in travel training programs.   

For the community service agency, travel training can allow clients 

to more readily access agency services.   

For the transit agency, every new rider who develops the skills and 

confidence necessary to use the transit system helps the agency to 

serve the community more effectively and increases ridership.  

People who may be able to switch some or all of their rides from 

specialized service providers to conventional transit, will free 

specialized transit resources to be reallocated to customers with less 

flexibility.  
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How does this generic travel training toolkit work? 

The purpose of this toolkit is to help transit agencies, working with 

community service providers, to provide travel training to new transit 

users who require it.   

Primary Roles of Partners 

 

 

This toolkit provides a training program template, based on best 

practices in other communities.  This template can be tailored to 

develop the program for each agency, incorporating the specific 
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relevant information for that community.  An orientation session 

organized by the transit agency is suggested to introduce trainers 

from community service providers to the program.  In some cases, 

the transit agency may also choose to deliver the training directly.   

The Travel Training Program is available for use by any transit 

agency, and will be made available by Metrolinx through an electronic 

medium.  Metrolinx will maintain contact with transit agencies on a 

periodic basis to better understand how effective the program is, how 

and where it is being used, and to get any updates on services so 

that the travel training program can be updated accordingly.  

Additionally, Metrolinx may seek to establish a travel training 

committee. 

This is a toolkit, not a one-size-fits-all program.  It is hoped that 

Transit Agencies and Community Service Providers will use some or 

all of the materials provided to develop a program that best suits their 

organization, objectives, training situation, and the learners’ needs.
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How this Toolkit is organized 

This toolkit provides a guiding framework and tools for constructing 

and delivering Travel Training Orientation and a Travel Training 

Program. 

The Toolkit has been divided into 2 sections: 

▪ Section 1 - Transit Agencies 

▪ Section 2 - Community Service Providers 

Each section outlines the steps for implementing each phase of the 

program.  These steps include information on how to get started, 

planning your programs, ways to customize, deliver, and promote 

the various programs, strategies to monitor success, and how to 

keep current.   

 Tools  

Each section makes reference to a series of tools and templates 

designed to support the agency in the delivery and implementation of 

the steps outlined in the guide.  The travel training materials are 

available through an electronic medium.  Refer to the table on the 

following pages for a complete list of materials and templates.  

Agencies may choose to use some or all of these tools as a starting 

point for their own program. 

 Resources  

The resources section is located at the end of this document and 

contains additional information that expands on the concepts 

presented in the Toolkit.  Refer to the table on the following page for 

a complete list of resources. 
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 Notes 

Notepads are found throughout the Toolkit. These sections provide 

additional information, background and suggestions for implementing 

a travel training program. 
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Travel Training Program Tools and Resources   

Agency Role Materials Document 
Location 

Metrolinx 

Develop materials All generic material Electronic 
medium 

Monitor and update Resources 

    

Transit 
Agency 

 

Assess transit 
system 

Transit System Accessibility Checklist Electronic 
medium 

Customize materials Accessibility Guidelines for Resources and 
Templates 

Resource A 

Travel Training Manual Electronic 
medium 

Traveller’s Handbook Electronic 
medium 

Promote to potential 
partner agencies 

Travel Training Overview Electronic 
medium 

Travel Trainer 
Orientation Package 

Demo Day Outline  Electronic 
medium 
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Agency Role Materials Document 
Location 

Planning an Accessible Meeting Resource B 

Deliver Travel 

Trainer Orientation 

Travel Trainer 
Orientation Package 

Travel Trainer Orientation 
Outline 

Electronic 
medium 

Participant Profile: Travel 
Trainer Orientation 

Electronic 
medium 

Transit 

Agency 

Deliver Travel 
Trainer Orientation 

Traveller’s Handbook Electronic 
medium 

Travel Training Manual Electronic 
medium 

Evaluate Travel 
Trainer Orientation 
and Travel Training 
Program 

Travel Trainer Orientation Evaluation Electronic 
medium 

Sample Data Collection Form: Transit Agencies Resource C 

    

Community 
Service 

Providers 

Promote Travel 
Training to clients or 
interested potential 
transit riders 

Traveller’s Brochure Electronic 
Medium 
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Agency Role Materials Document 
Location 

Deliver Travel 
Training 

Travel Training 
Manual: 
Assessment 
Tools 

 

▪ Travel Training Survey 
▪ Travel Training  Assessment 

Form 
▪ Road Safety Checklist 
▪ Travel Training Checklist 
▪ Travel Training Summary 

Electronic 
Medium 

Travel Training 
Manual: 
Evaluation 
Tools 

▪ Trainer Evaluation  
▪ Participant Evaluation  

▪ Follow-up Survey 

Electronic 
Medium 

Traveller’s Handbook Electronic 
Medium 

Community 
Service 

Providers 

Monitor Travel 
Training Program 

Sample Data Collection Form – Community 
Service Providers 

Resource D 
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1.1 Develop a Plan 

If an agency is thinking about providing travel training, developing a plan 

is a good place to start. 

Below are steps that should be taken in the implementation of a travel 

training program.  It should be noted that this Toolkit is specific to travel 

training and is not intended to be a strategic planning model.  Transit 

agencies may want to consider the following steps and questions when 

developing their plan for a travel-training program: 

▪ Establish a goal and specific objectives to accomplish it (e.g. 

“increase use of conventional transit by seniors and youth by x % 

within the next year”).   

▪ Identify who would take the travel training program (e.g. seniors, 

people with disabilities, individuals who are new to your 

community). 

▪ Identify and gauge interest from community service providers and 

prospective partners. 

▪ Identify, using this handbook as a guideline, the resources - staff, 

materials and funding - required to be able to develop and 

implement the travel training program. 

▪ What are the specific activities to be accomplished and within 

what timelines? 

▪ Which staff will be needed to develop and implement the 

program? 

▪ What resources and support materials will be needed? 

▪ What budget is available to implement the program? 

1.2 Get Started 
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1.2.1  Identify local community service providers 

and partners 

Partnering with local community service providers can be an effective 

way of developing and delivering a travel training program.  Community 

service providers have an in-depth understanding of the capacities and 

needs of their clients, and this understanding will be valuable in 

determining how the clients can get the most out of the travel training 

program.  Additionally, working with community service providers can be 

a more cost effective way of delivering travel training programs than 

having your own team of travel trainers. 

The following questions may be useful in identifying potential community 

service providers and partners:  

▪ What collaborative efforts exist with other public sector agencies 

(e.g. public health, public safety, education)? 

▪ Are there community groups, committees or networks that address 

the needs of groups who would benefit from travel training? 

▪ Which community partners will most effectively reach potential 

trainees?   

▪ Do they have access to staff or volunteers who will be able to 

deliver the program?   

▪ What will you need to do to support your community trainers? 

Potential partners include, but are not limited to: 

▪ Agencies serving people with disabilities, youth or seniors 

▪ Municipal departments or programs (e.g. Recreation) 

▪ Schools (e.g. Life Skills programs) 

▪ YMCAs/YWCAs or other community service organizations  
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1.2.2  Determine your current level of accessibility 

Before preparing travel training for potential riders who have disabilities, 

it is important to understand the level of accessibility of your system.  

The dictionary defines accessible as “able to be easily obtained or 

used”.  It is a term that can be understood in different ways by different 

people.  In reality, it will not be possible to have a facility that is 100% 

accessible to 100% of people.  The best approach is to increase the 

level of accessibility to try to accommodate as many people as possible.  

The purpose of this step is to ensure that your agency has 

systematically reviewed what barriers may exist for people with 

disabilities.    

Accurate and current information about the accessibility of the service is 

a particularly important part of planning a trip for anyone with 

accessibility needs.  A traveller can set out with increased confidence if 

they can confirm that their route is accessible.  On the other hand, if 

they are aware of a potential barrier, they can plan their trip around it.  

By clearly identifying accessible paths and areas that are not 

accessible, you are providing an important customer service, which will 

then make people much more comfortable using the transit system.   

The Transit System Accessibility Checklist was designed using 

current building code standards including the Ontario Building Code and 

relevant standards from the Canadian Standards Association, the 

Accessibility for Ontarians with Disabilities Act, 2005 (AODA) proposed 

Accessible Built Environment Standard, the Integrated Accessibility 

Standard and Customer Service Standard, as well as best practices in 

other regions.  It is designed to be a starting point in identifying the 

accessibility level of your system.  It should not be considered an 

acceptable substitute for the Building Code or AODA regulations.  If you 

would like extra help in assessing your facilities, you may choose to 

enlist an architect, or an AODA consultant who can conduct a full audit.  

They can also help to explain the regulations and assist in prioritizing 

any upgrades.   
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 The Transit System Accessibility Checklist will:  

▪ Help to identify accessible features in your transit system and 

opportunity to improve accessibility. 

▪ Be a resource in the customization of the generic travel training 

materials.  

The assessment should be conducted by designated transit staff.  

Asking Accessibility Advisory Committee members to participate in the 

process may help to ensure that various perspectives have been 

considered.  

It is important to maintain up-to-date information on the accessibility of 

the system.  The checklist should be updated to reflect any changes in 

accessibility and the travel training manual and handbook updated as 

needed.  

 

1.3 Customize the generic travel training resources 

 The next step is to customize the generic Travel Training Manual 

Template and the generic Traveller’s Handbook Template by adding 

specific information about your transit system, and the findings from the 

Transit System Accessibility Checklist.  

The items marked in blue in the template highlight the usual content that 

will need to be added. 

 When customizing the materials, be sure to create them in an 

accessible format.  The Accessibility Guidelines for Resources and 

Templates in the Resources Section provides helpful tips on creating 

accessible documents.  

The customized documents - the Travel Training Manual and the 

Traveller’s Handbook - will be used both for the Travel Trainer  
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 Orientation sessions offered to community service agency trainers 

and for delivery of the Travel Training Program by the trainers to 

travellers.  

 Using Video 

Video is a great tool for conveying information.  Visual cues and 

tools can reach a wide range of people with varying abilities.  If 

you have the budget, it is recommended that you develop a short 

orientation video to complement your customized travel training 

materials. 

See the links below for some examples of videos already being 

used by transit agencies:  

Peel Region: 

http://www.youtube.com/watch?v=Nv2m8IpGXDE 

TTC: 

http://www.ttc.ca/TTC_Accessibility/Easier_access_on_the_

TTC/Easier_Access_Video.jsp 

 

1.4 Deliver Travel Trainer Orientation 

The Travel Trainer Orientation, offered by the transit agency to trainers 

from community service providers, is intended to: 

▪ Provide trainers with an orientation to the transit system;  

▪ Educate community agency trainers on the accessible features of 

the system; 

▪ Familiarize them with the available training materials. 

 

http://www.youtube.com/watch?v=Nv2m8IpGXDE
http://www.ttc.ca/TTC_Accessibility/Easier_access_on_the_TTC/Easier_Access_Video.jsp
http://www.ttc.ca/TTC_Accessibility/Easier_access_on_the_TTC/Easier_Access_Video.jsp
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1.4.1  Identify prospective orientation leaders 

Who can provide the orientation?  

Transit agencies can: 

▪ Dedicate a staff position to the delivery of the Travel Trainer 

Orientation to community trainers; or 

▪ Contract a third party provider and designate transit personnel to 

oversee the contractor’s work.  

If a third party provider is being used to deliver the orientation, the 

transit agency will provide the customized travel training materials to the 

contractor and assist with the Travel Trainer Orientation program.  It is 

also recommended that a transit staff member co-facilitate the Travel 

Trainer Orientation. 

 

1.4.2  Promote Travel Trainer Orientation  

Transit agencies will need to promote the Travel Trainer Orientation 

sessions to local community service providers, and in turn promote the 

travel training program as a whole.  Transit agencies have successfully 

encouraged and supported community partners, using techniques such 

as: 

▪  Offering incentives for them to commit (e.g. fares for participants, 

discounted passes for trainers); 

▪  Supporting them in the delivery of the travel training program (e.g. 

providing transit staff and out-of-service vehicles for training 

sessions).   

The cost to implement a travel training program includes set up costs, 

operational costs for running the program, and travel fares.  If transit 
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agencies could provide full or partial funding community partners may 

be more likely to adopt the program.   

Each transit agency will need to discuss the budget and division of costs 

with partner community service providers to develop an arrangement 

which will work best for each situation.    

How can we go about promoting the program? 

▪ Promotional tools that can be used to introduce the program to 

potential community service agency partners include; 

▪  Printed materials such as the Traveller’s Brochure and Travel 

Training Overview in the Travel Training materials;  

▪  A “Demo Day” for local community service providers.  This 

could include an overview of the program and the accessible 

features of the system.  Refer to the Demo Day Agenda in the 

Travel Trainer Orientation Package for suggestions.  

 

1.4.3  Organize Travel Trainer Orientation  

 The following materials are available in the Travel Trainer 

Orientation Package:  

▪  Travel Trainer Orientation Agenda;  

▪  A Participant Profile will provide background information on 

the potential trainers and the community service provider they are 

representing.  This should be completed by the participant and 

returned prior to the session;  

▪  Determine location and, if necessary, consider the 

recommendations for Planning an Accessible Meeting;  

▪ Prepare copies of the customized Travel Training materials;  

▪ Have available hard copies of Schedules/Timetables and Route 

Maps;  
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▪ Have an out-of-service vehicle available, if appropriate, to 

demonstrate its’ accessible features. 

 

1.4.4  Deliver Travel Trainer Orientation 

The following questions may be worth considering when determining 

how to deliver a Travel Trainer Orientation session: 

How many participants will be taking part? 

▪ 10-12 participants are ideal for a session. 

How long will the orientation be? 

▪ Training sessions can range from 90 minutes to full-day sessions 

depending on available resources, number of participants and 

time constraints.  It is recommended to set aside enough time to 

fully cover the training materials and to provide a “demo” ride on 

an out-of-service vehicle, if appropriate.  It would also be of benefit 

to the prospective travel trainers to receive an orientation of a 

station when applicable. 

 

1.5 Support Community Service Providers and Partners 

Community service providers and partners should be engaged regularly 

and in person while they are delivering the travel training program.  

Continuous engagement provides opportunities to solicit and receive 

feedback, build cooperation and a sense of purpose and direction.   

The following may be useful ideas for supporting community service 

providers: 

▪ Providing an on-site vehicle for training, where possible;  
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▪ Delivering 90-minute demonstration and general information 

session to their members; 

▪ Providing fares to trainers and participants to be used during 

travel training;  

▪ Giving fare incentives to those who successfully complete the 

training program;   

▪ Establishing a committee or engage participating agencies in 

regular meetings to solicit and receive feedback, identify best 

practices and opportunities for improvement. 

 

1.6 Monitor Your Success 

 

1.6.1  Evaluate Travel Trainer Orientation 

Evaluating the Travel Trainer Orientation on a regular basis is a good 

way of continually improving elements such as the format and delivery 

of the orientation.   

 Travel Trainer Orientation participants can provide feedback on the 

session and also gauge their confidence and preparedness in delivering 

the Travel Training program by filling out the Travel Trainer 

Orientation Evaluation upon completion of the session.  

 

1.6.2  Evaluate success of Travel Training         

Program 

 It is reasonable to expect that each individual who has participated in 

a program sponsored by the transit system will begin using transit for at 

least some of their travel needs.  If they previously used the specialized 
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transit system, the trainee may be able to reduce his or her dependence 

on specialized transit, therefore making travel training cost effective.  At 

the conclusion of a travel training program, transit agencies may want to 

request that the community service provider perform a formal evaluation 

to determine the effectiveness of the training delivered.  Refer to the 

Follow-up Survey in the Travel Training Manual.  

 

1.6.3  Collect, support, and maintain statistics 

Many of the benefits of independent travel relate to the quality of life of 

the participant.  It is also important however to take into account the 

financial savings that can be made in the long-term as a result of 

reducing dependence on paratransit.   

In order to calculate the savings generated through promoting a travel 

training program an effective data collection system is key.  Factors that 

should be considered include the cost of delivering travel training 

orientation, administrative costs, and any incentives that may be 

provided for the community partners (e.g. fares).  It is important to not 

overlook these costs when assessing net savings. 

 Refer to the Sample Data Collection Form in the Resources 

Section for an example of items to monitor.  

Along with the information you may be tracking, the community service 

providers could also collect statistical data regarding the program.  

Transit agencies may wish to request information from their community 

partners to assess the cost and effectiveness of the program. 

 1.7 Keep Current 
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1.7.1  Stay connected with participating community 

service providers and partners 

Establishing a regular schedule for communicating with participating 

agencies and partners offers an opportunity to exchange information 

about the success of the program, discover areas for improvement and 

develop strategies for success.  Here are a few tips: 

▪ Provide a contact for community partners to reach with questions, 

suggestions, and requests for support; 

▪ Schedule regular meetings to discuss the successes and 

challenges of the training program;  

▪ Provide annual refresher training to trainers from participating 

agencies. 

 

 

1.7.2  Update and monitor travel training materials 

The information provided to participating community service providers 

should be monitored for updates and additional resources.  Here are a 

few things to consider: 

▪ Who will update the resources? 

▪ How will participating agencies be notified of the changes?  
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2 Community Service Providers 

2.1: Develop a Plan 

2.2: Get Started 
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2.4: Promote Travel Training Program 

2.5: Monitor Your Success 

2.6: Keep Current 
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2.1 Develop a Plan 

Travel training is an excellent program option available for community-

based organizations whose mandate is to increase independence, 

community participation and engagement for participants.  The program 

is designed in a manner that allows it to be customized to meet the 

needs of consumers.  It can be offered as a stand-alone program or as 

an integral part of an existing program. 

Below are steps that should be taken in the implementation of a travel 

training program.  It should be noted that this Toolkit is specific to travel 

training and is not intended to be a strategic planning model.  Community 

service providers may want to consider the following steps and questions 

when developing their plan for a travel training program: 

▪ Establish a goal and specific objectives to accomplish it (e.g. 

“increase use of conventional transit by seniors and youth by x % 

within the next year”);   

▪ Identify who would take the travel training program; 

▪ Identify who will deliver travel training; 

▪ How many trainers will be needed? 

▪ Will trainers be staff members or volunteers? 

▪ Identify, using this handbook as a guideline, the resources - staff, 

materials and funding - required to be able to develop and 

implement the travel training program; 

▪ What are the specific activities to be accomplished and within 

what timelines? 

▪ Which staff will be needed to develop and implement the 

program? 

▪ What resources and support materials will be needed? 

▪ What budget is available to implement the program? 

▪ Deliver travel training; 
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▪ Are the necessary resources (staff, materials and funding) 

available to deliver travel training to your consumers? 

▪ Will the supporting transit agency provide fares for the participant 

and trainer during training?  

▪ Will the supporting transit agency provide out-of-service vehicles 

and staff for training? 

▪ Sustain, monitor and update the program; 

▪ Who will continue to co-ordinate the program in the future? 

▪ Will the supporting transit agency provide fare incentives for 

participants who have completed of the program? 

 

2.2 Get Started 

2.2.1  Identify staff and volunteers for Travel 

Training Orientation 

Travel Training Orientation sessions will be provided by the transit 

agency.  The recruitment and training of good quality instructors is 

essential to the success of a travel training program.  Travel trainers are 

responsible for the initial assessment of potential users of public transit 

as well as instruction within the community.  They must have the skills 

and knowledge to determine eligibility, and develop instructional 

programs based on the materials provided and the accessibility of the 

transit system in their regions. 

Who are your travel trainers? 

Depending on the scope of the program and the size of the 

organization, the staffing requirements of a travel training program can 

vary.  Typically, a travel trainer would be: 

▪ An agency staff member who has either a full-time or part-time 

training responsibility; 
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▪ A volunteer travel trainer. 

Volunteer travel trainers 

Some community service providers find success in a volunteer-based 

training program.  These volunteers often are graduates of the travel 

training program. 

One method that has been successful with past participants is the Buddy 

System.  These are commonly youth and seniors who are comfortable on 

the local transit system.  After a group session has been offered, this 

‘buddy’ would be available to accompany and support other trainees on 

outings.  This will give the new participant an opportunity to practice their 

new skills with an experienced traveller.  

Qualities of an effective travel trainer: 

▪ Good base of knowledge of the transit system; 

▪ Has excellent judgment and problem solving skills;  

▪ Trustworthy;  

▪ Possesses a level of maturity to work independently in potentially 

high-risk situations; 

▪ Strong understanding of the needs of their learners.  

 

2.2.2  Identify participants for the travel training 

program 

Participants for your travel training program can be: 

▪ Consumers or program participants within your organization; 

▪ Referrals from outside agencies and programs (e.g. schools, adult 

service agencies, independent living programs); 

▪ Self-referrals. 
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What skills are required for travel training? 

The travel training program is for people who: 

▪ Are motivated; 

▪ Are physically able to get to the bus stop/station and to get on and 

off a bus; 

▪ Have cognitive and reasoning abilities to follow a route; 

▪ Have coping mechanisms to adapt to change and stressful 

situations; 

▪ Are able to identify numbers and understand currency; 

▪ Have a general understanding of, and experience in, travelling 

outside of the home; 

▪ Are able to learn to communicate their needs to a bus driver; 

▪ Understand the need for appropriate social behaviour. 
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2.2.3  Develop selection and registration process for 

travel training participants 

How will you decide who will be a part of your travel training 

program? 

The most effective way is for participants to decide for themselves. 

Offer the program to your consumers/participants.  If the resources are 

available, you may also choose to promote the program to agencies that 

do not offer travel training.  In this situation, a referral system could be 

developed with these organizations. 

Should there be a fee for the program? 

It is up to the organization.   

Budget is certainly a consideration.  Research has shown that programs 

that charge a fee have higher retention and success rates because of 

the sense of ownership and commitment a cost instills.  A pay-what-

you-can or sliding-scale fee is one option that may encourage people 

with different economic means to participate in the program. 

Program costs will also vary depending on the type of program being 

delivered.  Refer to 2.3.2 for detailed descriptions of the travel training 

programs. 
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2.3 Select Components of Travel Training Program 

2.3.1  Know your learners 

Each community agency will deliver a program that suits their needs 

and the needs of their consumers.  The agency will decide on the 

frequency and format of training sessions on an ongoing basis, while 

keeping in mind the demand from participants and their organizational 

capabilities.  

Travellers who use mobility devices will benefit most from travel 

trainers who have a good working knowledge of a variety of mobility 

devices.  It would be best for the trainer to understand the function of 

the device, the securement system, and some basic troubleshooting 

ideas in case of problems while away from the traveller’s home. 

The following sections may be helpful in determining what type of 

program and assessment tools will best meet the needs of your 

learners.  Group training may be appropriate for many consumers, but 

a more intensive program may be better suited for others.  

Persons who have vision loss require specialized assessments 

and training from certified Orientation and Mobility (O&M) Specialists.  

“Travel Training” is not a replacement for O&M Training.  If you require 

more information about O&M Training, please contact CNIB at 1-800-

563-2642. 
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2.3.2  Travel Training Program Descriptions 

Type of 

Program 
Type of Service 

Learning 

Environment 
People served Budget 

General 

Orientation 

Training 

▪ Least comprehensive 

▪ 90 minute session  

▪ Group training 

▪ Classroom 

setting  

▪ In the 

community  

▪ May have some 

experience using the 

system 

▪ Do not require one-on-

one training (e.g. senior’s 

residence) 

▪ Less costly 

▪ Requires less 

time and fewer 

trainers 

Personal 

Mobility 

Device 

Training 

▪ Moderately comprehensive 

▪ 90-minute session with 

additional practice in the 

community 

▪ Group or one-on-one 

training 

▪ Classroom 

setting  

▪ In the 

community  

▪ Individuals who use 

mobility devices and need 

additional skills to board, 

ride, and disembark 

vehicles 

▪ Reflected in the 

number of hours 

required per 

participant 

▪ Less costly if 

training is 

delivered in 

groups 

Destination 

Training 

▪ Most comprehensive 

▪ Can range in length from 

one session to multiple 

sessions 

▪ Individual’s 

home 

▪ Classroom 

setting  

▪ May have gaps between 

current skill level and 

those needed for 

independent travel (e.g. 

consumer in a stroke 

▪ Most costly 

▪ Involves 

assessment as 

well as training 
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Type of 

Program 
Type of Service 

Learning 

Environment 
People served Budget 

▪ One-to-one training 

▪ Initial and ongoing 

assessment tools are 

recommended 

▪ In the 

community 

recovery) program with a 

cognitive disability 
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2.3.3  Select approach to travel training 

The level of training will vary based on the individual needs and skills of 

each learner.  Therefore, the program should be thoroughly planned 

and well supported and take into account all the variables that may 

occur during training. 

 Training can be delivered in group or one-to-one sessions and vary 

in duration and level of assessment.  Three recommended approaches 

to travel training are: General Orientation Training, Personal Mobility 

Device Training (where applicable), and Destination Training.  All 

three approaches are covered in detail in the Travel Training Manual 

that will be provided by your partnering transit agency.  The Travel 

Training Manual contains information, guidance, and resources for 

travel trainers on the delivery of each travel training program.  These 

programs should also be delivered in conjunction with the Traveller’s 

Handbook.  This resource will also be provided by the transit agency 

and is a takeaway tool for the participant to use during training and as a 

resource in their travels.  

It is up to you as an organization to decide which components of the 

program will meet the needs of your consumers.  

Would group training or one-on-one training be more appropriate 

for your consumers? 

When choosing the appropriate travel training program for your 

organization and for the participant, it is important to consider: 

▪ Available resources and budget; 

▪ Level of risk for the participant, taking into account health and 

safety concerns; 

▪ The participant’s cognitive and physical abilities, which will help to 

determine if the participant will succeed in the program. 
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With any one of the travel training programs, participants can be 

paired up with a partner with similar goals and undergo training 

together.  This will help to increase the confidence in both participants 

and add an element of safety in their travels. 
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  2.3.4  Travel Training Program Materials  

 Destination Training 
General Orientation 

Training 

Personal Mobility 

Device Training 

Pre-

Assessment  

Travel Training 

Assessment Form 

Travel Training Survey Travel Training Survey or 

Travel Training 

Assessment Form 

Participant 

Materials 

Traveller’s Handbook Traveller’s Handbook Traveller’s Handbook 

On-going 

Assessment 

Road Safety Checklist N/A N/A 

Travel Training Checklist N/A N/A 

Final 

Assessment 

Travel Training Summary N/A N/A 

Program 

Evaluation 

Participant Evaluation of 

the Travel Training 

Program 

Participant Evaluation of the 

Travel Training Program 

Participant Evaluation of 

the Travel Training 

Program 



 

 25 

 Destination Training 
General Orientation 

Training 

Personal Mobility 

Device Training 

Trainer Evaluation of the 

Travel Training Program 

Trainer Evaluation of the 

Travel Training Program 

Trainer Evaluation of the 

Travel Training Program 

Follow-up Follow-up Survey Follow-up Survey Follow-up Survey 
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2.3.5  Choose assessment tools to meet learner 

needs 

 Not all travel training programs will require a method of 

assessment.  The Travel Training Assessment Tools are 

resources for community service providers based on best practices.  

It is up to the discretion of agencies delivering the program to 

determine which tools would be suitable, or necessary, for 

consumers.  These tools may also help to determine the most 

appropriate level of training for the participant.  

 Most of the assessment materials are recommended for use with 

Destination Training and are found in the Travel Training 

Manual.  

The following table provides a summary of assessment tools 

recommended for each of the travel training programs: 

 Training Program 
 General 

Orientation 

Training 

Personal Mobility 

Device Training 

Destination 

Training 

Initial 

Assessment 
▪ Travel 

Training 

Survey 

▪ Travel Training 

Survey or 

▪ Travel Training 

Assessment Form 

▪ Travel Training 

Assessment 

Form 

Ongoing 

Assessment 

N/A N/A ▪ Road Safety 

Checklist 

▪ Travel Training 

Checklist 

Final 

Assessment 

N/A ▪ Travel Training 

Summary 

▪ Travel Training 

Summary 
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Initial Assessment 

 Travel Training Survey  

The Travel Training Survey was designed as a means for 

agencies to collect information from participants taking part in 

General Orientation Training and Personal Mobility Device 

Training, where a thorough assessment and consultation is not 

necessary.  

The Travel Training Survey: 

▪ Addresses the participant’s goals; 

▪ Collects contact information; 

▪ Is completed by the participant prior to training. 

 Travel Training Assessment Form  

When training individuals who may be at higher risk or require more 

support, it is recommended that more comprehensive tools be used 

to assess the participant.  Assessing risks and ensuring safe travel 

are important parts of travel training.  The Travel Training 

Assessment Form is recommended for Destination Training. 

The Travel Training Assessment Form can be used in the following 

ways: 

▪ As a self-assessment by the potential trainee; 

▪ As a guide for the in-person interview;    

▪ To customize the program to best suit the needs of each 

individual participant.  

In-person Assessment 

An In-person Assessment is also recommended for Destination 

Training as the trainer can observe the communication and 
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cognitive abilities of the participant as well as expand on the 

questions asked in the Travel Training Assessment Form. 

Ongoing Assessment 

Ongoing assessment should be conducted by a travel trainer 

throughout Destination Training to gauge the success of the 

participant.  The trainer should be looking to see that the participant 

has mastered a certain set of skills that would make it safe for them 

to travel independently on public transit.   

This level of assessment isn’t necessary for General Orientation 

Training and Personal Mobility Device Training. 

Recommended tools for Destination Training include the: 

▪  Road Safety Checklist  

▪ Assesses pedestrian skills;  

▪ Can be used during the initial assessment period and 

throughout training.   

▪  Travel Training Checklist  

▪ Assesses skills while travelling on public transit; 

▪ Can be used during the practical on-the-street component of 

the training. 

Final Assessment 

Depending on the level of training, the trainer may choose to 

conduct a final feedback session (assessment) with the participant.  

It is recommended that this occurs with Destination Training, and 

in some cases Personal Mobility Device Training.   The Travel 

Training Summary was developed for this purpose.  

The Travel Training Summary can be used for:  
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▪ Providing an overview of the training delivered; 

▪ Commenting on the goals achieved; 

▪ Sharing recommendations for future travel. 

It is best to focus on the successes of the participant – a “Pass/Fail” 

approach is not encouraged.  If the participant is not prepared to 

travel independently, additional training or travel with a “Buddy” 

should be recommended. 

 Privacy and Confidentiality 

Participant assessment is used as a means to acquire information 

in order to customize the travel training program to suit the 

participants’ needs.  It can also be used to assess the possible 

risks involved for the participant taking the program.  For more 

thorough training some medical information will be documented.  

Taking this into account, consider who will be viewing the 

assessment forms. 

▪ It is recommended that forms are returned to the participant 

upon completion of the program. 

▪ The exception may be in cases where the assessment 

process plays a part in a larger intervention where the agency 

requires the documentation. 

 

2.4 Promote Travel Training Program 

Community service providers may want to choose to promote the 

program through agency events and programs using: 

▪ Flyers and information pages - Information about the program 

can be added to an agency’s website and social media 

networks, or included in newsletters; 

▪ Videos;  
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▪  Traveller’s Handbook;  

▪  Traveller Brochure;  

▪ Group travel training sessions – These sessions in 

themselves are a way to promote further one-on-one training. 

2.5 Monitor Your Success 

 

2.5.1  Evaluate the Travel Training Program 

An agency will be able to determine the quality of its travel training 

program by the accomplishments of the program.  

▪ Did the program reach the targeted population? 

▪ Was the training completed within the established 

timeframes?  

▪ Were all trainees properly assessed? 

▪ Were those trained able to travel safely and independently on 

public transit after completing the program? 

▪ Have participants been able to reduce their use of specialized 

transit after completing the program? 

▪ Were participants satisfied with the program? 

The evaluation findings can be useful in identifying opportunities to 

improve and update the format and delivery.  The methods of 

evaluation for this program are: 

▪  Trainer Evaluation of the Travel Training Program;  

o An evaluation of the travel training program by the 

trainer;  

▪  Participant Evaluation of the Travel Training Program;  

o An evaluation of the travel training program and the 

trainer by the participant; 
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▪  Follow-up Survey;  

o Completed by the participant within 90 days of 

completing the program; 

o Evaluates effectiveness of the program and ridership 

information (e.g. whether the participant has switched 

from paratransit to public transit). 

 

2.5.2  Collect, support, and maintain statistics 

Travel trainers and administrators make a plethora of decisions 

regarding program operations.  Collecting and analyzing useful 

data can help to establish a factual basis for these decisions.   

 Refer the Sample Data Collection Form in the Resources 

section for some suggestions of items to keep track of.  

A successful data collection system provides an opportunity to:  

▪ Identify the key characteristics to be measured;  

▪ Delineate a process for measuring these characteristics;  

▪ Make decisions about what to do with the data that is 

collected.  

An effective data collection system can be quite valuable in 

answering basic questions such as:  

▪ How do we know when the trainee is ready to travel 

independently?  

▪ How much time does it take to teach each trainee?  

▪ What is the cost of providing this travel training program?  

▪ It is important to determine who will be accountable for 

maintaining statistics regarding the travel training program 

within your organization.  The transit agency and Metrolinx 
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may require this data from you to assess the success of the 

program.  
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The basic components of an effective data collection system 

are: 

▪ Key characteristics to measure;  

▪ An operational definition of the key characteristics;  

▪ A process for obtaining useful data;  

▪ A process for analyzing the data;  

▪ A decision about what to do with the data collected.  

 

2.6 Keep Current 

 

2.6.1  Update and monitor travel training 

materials 

It is important to maintain a relationship with the transit agency.  

They may be providing staff and on-site vehicles for training 

sessions, but it is still important to check in with them outside of the 

training environment. 

The benefits of connecting with the local transit agency on a regular 

basis are to: 

▪ Inquire about service updates and travel incentives; 

▪ Get updated materials (e.g. training materials, maps, etc.); 

▪ Provide feedback and statistical findings on your travel 

training program; 

▪ Find out about upcoming refresher courses for trainers. 
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3  Resources  

 

Resource A: Accessibility Guidelines for Resources and 

Templates 

Resource B: Planning Accessible Meetings 

Resource C: Sample Data Collection Form –Transit Agencies 

Resource D: Sample Data Collection Form – Community 

Agencies 

Additional Information 
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Resource A: Accessibility Guidelines for Resources 

and Templates   

Accessibility Tips for Customizing the Traveller’s 

Handbook 

The Traveller’s Handbook template has been structured for 

accessibility.  Here are some tips to ensure that accessibility is 

maintained as you modify the content: 

Note: Techniques described below are based on Word 2007 

1 When adding images, ensure that they are formatted correctly 

Images should be formatted as in-line objects so that the images 

retain their position in the page and stay constant in relation to the 

nearby text.  

When you use the default techniques for inserting images, the 

images default to being “in-line” objects. 

To confirm that the image is an ‘in-line’ object: 

1) Select the image; 

2) Go to Page Layout menu;  

3) From the Arrange section, Select Position;  

4) Select In Line with Text. 

 

Here is an example of using an image with correct formatting: 

 Check the bus name and number before you get on 
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2 Add alternative text for all images 

All images should have descriptive alternative text that concisely 

describes the information that the image is conveying. 

To add alt-text: 

1) Right click on the image; 

2) Select Size from the context menu;  

3) Select the Alt text tab in the Size dialog; 

4) Enter a meaningful, concise description of the image; 

5) Close the dialog. 

e.g. 

           

3 Use style elements to format headings 

To apply headings using the Styles toolbar: 

1) Select Heading text; 

2) Select the Heading Level from the Home Menu > Styles 

Section. 

 

Styles used in the Traveller’s Handbook: 

Section Headings: Heading 1  

Subsection Headings: Heading 2 

Subsection Headings: Heading 3 

4 Add the Title, Subject, Keywords, Author and Language to 

the document properties: 

1) Click on the Office Button; 
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2) Select Prepare > Properties; 

3) Complete the relevant fields in the document properties form; 

4) Select English from the Language dropdown; 

5) Click the Save button to close the document properties. 

Making Print Material More Accessible 

Reading is critical to full participation in society.  For many 

individuals, reading presents a major challenge and there are many 

variables that can affect reading performance.  The following points 

have been found to enhance reading performance, thereby making 

print merchandise, service and information accessible to everyone.  

Please keep these guidelines in mind as you customize the templates 

and produce promotional material. 

General Recommendations 

1   Contrast 

▪ Use high contrast colours for the text and background.  Good 

examples are black or dark blue colours on a white or yellow 

back ground, or white/yellow text on black or dark background. 

2 Type Colour 

▪ Print material is most readable in black and white.  If using 

coloured text, restrict it to titles, headlines or to highlight 

material. 

3 Point Size 

▪ The preferred point size is 12 to 18 points - 12 to 14 point for 

the body and 16 to 24 for headings.  Consider the audience 

when choosing the point size. 

4 Leading 

▪ Leading is the space between lines of text and should be at 

least 25 to 30 percent of the point size.  This enables readers 

move more easily to the next line. 
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5 Font Style and Heaviness 

▪ Avoid complicated or decorative fonts.  Use upper and lower 

case fonts.  The preferred fonts are Arial, Verdana and 

Tiresiais. 

▪ Select fonts with a medium heaviness and avoid light type with 

thin strokes.  When emphasizing a word or passage, use a bold 

or heavy font.  The use of italics or upper-case letters is not 

recommended. 

6   Letter Spacing 

▪ Do not crowd your text: keep a wide space between letters. 

7 Margins and Columns  

▪ Separate text into columns to make it easier to read, as it 

requires less eye movement and less peripheral vision.  

Consider using wide binding margins or spiral bindings if 

possible.  Flat pages work best for vision aids such as 

magnifiers. 

▪ Use plenty of white space to improve the readability of the 

documents. 

8 Paper Finish 

▪  Consider using a matte or non-glossy finish to cut down on 

glare.  Reduce distractions by not using water marks or 

complicated background designs. 

9 Design 

▪ Use distinctive colours, shapes and sizes on covers of material 

to make them easier to distinguish. 

▪ Use frames around text. 

▪ Use bullets when describing a process.  

10 Keep it Simple 

▪ Use simple words. 

▪ Use pictures/symbols to explain words. 

▪ Write text in short sections versus large paragraphs. 
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Making Electronic Documents More Accessible 

Creating Accessible Word Documents 

When creating electronic documents, consider the recommendations 

below.  Following these guidelines will often make web content more 

functional and accessible to users in general. 

 

1 Structure 

▪ Add Structure to your document using Headings Styles; 

▪ When creating lists, use the “start bulleted list” or “start 

numbered list”;  

▪ Create a Table of Contents for long documents. 

2 Tables 

▪ Structure tables for easy navigation; 

▪ Use tables only for data, not just as a way to lay out text on the 

page;  

▪ Use “real tables”: do not use the tab key to space text to look 

like a table; 

▪ Define the first row as column headers by setting the “Repeat 

as header on the top of each page” in the “Table Properties” 

menu; 

▪ Keep tables simple and avoid using merged cells. 

3 Images 

▪ Add Alternative text descriptions to all images and graphical 

objects; 

▪ Keep images in-line with text; 

▪ Use “floating elements” by positioning images to remain “inline 

with text”. 
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4 Text 

▪ Do not use colour as the only way to convey information;  

▪ Avoid using Word Art; 

▪ Avoid using Text Boxes; 
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  Testing Tip 

Microsoft Word 2010 has a built-in accessibility checker that will look 

for the presence of headings, alt-text and other accessibility issues.  It 

works much the same as the spell checker and points out 

accessibility errors, warnings and tips. 

To run the accessibility checker, select File > Info > Check for 

Issues > Check Accessibility 

Microsoft Word Office Accessibility Checker: 

http://office.microsoft.com/en-us/starter-help/accessibility-checker-

HA010369192.aspx 

References for Creating Accessible Word Documents 

IBM Documentation Accessibility Checklist  

http://www-

03.ibm.com/able/guidelines/documentation/accessdoc.html 

WebAIM, Create Accessible Word Documents 

http://webaim.org/techniques/word/ 

Microsoft Accessibility http://www.microsoft.com/enable/ 

Microsoft Office, Create Accessible Word Documents: Quick 

Reference Card http://office.microsoft.com/en-us/support/quick-

reference-card-

RZ102644124.aspx?CTT=5&origin=HA102671874&section=8&mode

=print 

Accessible Digital Office Document (ADOD) Project, Authoring 

Techniques for Accessible Office Documents Authoring Techniques 

for Accessible Office Documents:  http://adod.idrc.ocad.ca/ 

http://office.microsoft.com/en-us/starter-help/accessibility-checker-HA010369192.aspx
http://office.microsoft.com/en-us/starter-help/accessibility-checker-HA010369192.aspx
http://office.microsoft.com/en-us/starter-help/accessibility-checker-HA010369192.aspx
http://www-03.ibm.com/able/guidelines/documentation/accessdoc.html
http://www-03.ibm.com/able/guidelines/documentation/accessdoc.html
http://webaim.org/techniques/word/
http://www.microsoft.com/enable/
http://office.microsoft.com/en-us/support/quick-reference-card-RZ102644124.aspx?CTT=5&origin=HA102671874&section=8&mode=print
http://office.microsoft.com/en-us/support/quick-reference-card-RZ102644124.aspx?CTT=5&origin=HA102671874&section=8&mode=print
http://office.microsoft.com/en-us/support/quick-reference-card-RZ102644124.aspx?CTT=5&origin=HA102671874&section=8&mode=print
http://office.microsoft.com/en-us/support/quick-reference-card-RZ102644124.aspx?CTT=5&origin=HA102671874&section=8&mode=print
http://adod.idrc.ocad.ca/
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Plain Language Association International 

http://www.plainlanguagenetwork.org/ 

 

http://www.plainlanguagenetwork.org/
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Creating Accessible PDF Documents 

PDF documents are usually created using other programs such as 

Microsoft Word or Adobe InDesign.  It is important that the source 

document be created following accessibility design principles and that 

it is converted to PDF in a manner that preserves document structure.  

Please consider the recommendations below when creating PDF 

documents.  For more information on creating accessible source 

documents and PDF conversion, please refer to the References 

section below. 

1 Structure 

▪ Ensure that the text is structured in a logical reading order.  

▪ Add Structure to the document by adding the appropriate tags.  

Document structure tags in a PDF define the reading order and 

identify headings, paragraphs, sections, tables, and other page 

elements. 

▪ Use bookmarks to assist with navigation. 

2 Language 

▪ Set the document language. 

▪ DO NOT create a PDF document from a scanned image.  

These image documents are not accessible. 

3 Images 

▪ Add alt-text to all images. 

▪ Add Structure to the document by adding the appropriate tags.  

Document structure tags in a PDF define the reading order and 

identify headings, paragraphs, sections, tables, and other page 

elements. 

▪ Use bookmarks to assist with navigation. 

4 PDF forms: 

▪ Ensure that the forms are interactive and fillable. 

▪ Add labels to all form fields. 
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▪ Use standard interactive form fields (e.g. text field, checkboxes, 

list boxes, buttons, radio buttons). 

▪ Ensure that the form fields are arranged in a logical tab order.  

▪ Adjust document security settings to enable text access for 

screen readers. 

 Testing Tip 

Adobe Acrobat has a number of built-in tools that you can use for 

checking accessibility: 

▪ Use Accessibility Quick Check to check for document structure 

tags, searchable text, and appropriate security settings for 

accessibility.  

▪ Use Reflow view to quickly check reading order.  

▪ Use Read Out Loud to experience the document as it will be 

perceived by readers who use this text-to-speech conversion 

tool.  

▪ In Adobe Acrobat, use the Touch Up Reading order tool to 

create a logical document structure. 

References for Creating Accessible PDFs 

IBM Documentation Checklist http://www-

03.ibm.com/able/guidelines/documentation/accessdoc.html 

Accessible Digital Office Document Program: Authoring Techniques 

for Accessible Office Documents http://adod.idrc.ocad.ca/ 

 WebAIM PDF Accessibility http://webaim.org/techniques/acrobat/ 

Adobe:  Accessibility: Best Practices 

http://www.adobe.com/accessibility/best_practices.html 

 

http://www-03.ibm.com/able/guidelines/documentation/accessdoc.html
http://www-03.ibm.com/able/guidelines/documentation/accessdoc.html
http://www-03.ibm.com/able/guidelines/documentation/accessdoc.html
http://adod.idrc.ocad.ca/
http://webaim.org/techniques/acrobat/
http://www.adobe.com/accessibility/best_practices.html
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Creating Accessible Forms in Word 

An “accessible” form is one that an assistive technology user can read 

and fill in independently.  If you are using Word to create a form, there 

are a number of things to consider: 

▪ Use the Word Forms toolbar to create your form. 

▪ Provide an accessible label for any form elements on the page.  

▪ Ensure that any text, form elements, or other elements are 

presented in a logical reading order. 

▪ Save the form as a protected document for distribution. 

 

Step 1: Creating your form 

1 Enter all of your static text. 

Static text includes instructions and supporting information to 

facilitate filling in the form.  Be sure to use Headings and Word 

Heading Styles to provide some structure in the document.  

2 Insert the desired form element (text, drop-down, checkbox): 

▪ Call up the Word Forms toolbar.  Go to the Developer Tab > 

Controls Section 

(Please see Word help for how to do this for your version of 

Word.  Instructions below are for Word 2007) 

      

▪ Type the form element label.  

It is best practice to place the label to the left of the associated 

form element, not above it. 
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▪ Create the Desired form element using the Legacy Form 

Controls (Note: the other controls are not accessible). 

          

 

3 Add Help Text: 

Help text is used to ‘associate’ the label and the form element.  This 

text appears in the word status bar as you tab or click on a form 

element and is also read aloud by assistive technology.  

▪ Right Click on the form element and select Properties. 
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▪ The Form Element Properties Dialog appears. 

 

 

▪ Type in Help Text.  

In most cases, it is best to type in the same question that is printed 

on the form.  If there is additional instructional information that is 

useful for filling in the form, enter it in Help Text (Note: the limit is 

138 characters). 
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Step 2: Creating Sections in your form  

In preparation for creating a protected Word form, it is necessary to 

differentiate between areas of the form with large areas of 

instructional text (e.g. consent statements) and areas of the form that 

are fillable.  A section break should be added between these areas.  

Note: This step is optional and is dependent on the design of the 

form. 

To insert a Continuous Section Break between the read-only text and 

the section of the form containing form elements: 

Page Layout > Breaks > Continuous Section break 

         

 

Step 3: Save your document as a protected form 

In preparation for distributing the form, it is necessary to protect it.  In 

a protected form, the user can tab through each form element and 

enter the data required in that field.  
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▪ Developer tab > Protect Document > Restrict formatting and 

Editing 

 

           

 

▪ The ‘restrict formatting and editing’ toolbar appears; 

▪ Check the “Allow only this type of editing in the document” 

checkbox; 

▪ Select “filling in forms” from the drop-down; 

▪ If using sections, click on the “select sections” link; 

▪ Check which section should be protected. This is the section 

containing the form elements; 

▪ Click on the Start Enforcing Protection button; 

▪ Save the file for distribution. 
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Guidelines for Creating Accessible Videos 

▪ Plain language should be used in all training materials, and the 

use of acronyms should be avoided.  

▪ Video or audio content should include the use of captioning, 

and the placement of captioning should not interfere with the 

picture (you will see this happen during some programs on 

television and the top of the head will be cut off, etc.) 

▪ Sometimes captioning font and colour can be changed through 

keyboard keys to increase the font or decrease and change the 

background.  

▪ Timing/speed of captioning is important and must show up at 

the right time.  

▪ If colour and size cannot be changed, then font should be 

consistent with CNIB guidelines, with white on black as the 

preferred choice. 
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Resource B:  Planning an Accessible Meeting 

When you are planning a meeting or event, it is important to ensure 

that everyone can participate, including people with disabilities.  By 

planning ahead, accessibility can be incorporated into every aspect of 

the meeting. 

The two main areas to consider when planning an accessible meeting 

or event are: 

▪ Physical access to the meeting space; and  

▪ Access to the meeting contents and proceedings. 

Here are some general things to keep in mind: 

▪ Make sure that a staff member is responsible for making the 

event accessible.  

▪ Be prepared to respond to accommodation requests in the same 

manner as other requests and questions about the event.  

▪ Make sure that the invitation or notice of meeting includes 

information about the accessibility of the event.  

▪ Planning for a longer event, such as a conference that will take 

place over several days, takes more organizing.  It would be 

helpful to find out ahead of time what resources are available 

locally, such as:  

o Sign language interpreters;  

o Accessible transportation;  

o Emergency veterinarians (for service animals); and  

o Wheelchair repair services.  
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▪ Before confirming the date of the event, it would be helpful to 

find out if other disability-related events are taking place in the 

area at the same time.  This may have an impact on your event 

and the availability of service providers.  

▪ As soon as the date of the event is confirmed, book and 

schedule sign language interpreters and/or real time captioners.  

▪ If the event's participants are responsible for their own meal 

arrangements, find out what local restaurants are accessible.  

▪ Look into the availability of installed or portable FM Listening 

Systems in meeting facilities for people who have a hearing loss 

(an FM system consists of a transmitter used by the speaker and 

a receiver used by the listener).  

▪ Find out if telephones with auditory adjustments for people who 

have a hearing loss are available.  

▪ Check to determine whether there are visual fire alarms.  If not, 

ask about the facility's evacuation plan or consider creating one 

for the event.  

▪ Find out if TTY is available, and make sure that staff know how 

to use it (a TTY is a device that is used by persons who are deaf 

or hard of hearing to communicate by telephone).  

▪ Make sure there is at least one telephone that can be used by a 

person who uses a wheelchair or scooter.  

▪ If a website is being used to promote the conference, make sure 

the site is accessible for people who use assistive technologies 

(such as screen reading software).  
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▪ Check to see if the customer service areas (i.e. counters, display 

tables, etc.) are low enough so that people who use wheelchairs 

or scooters can use them effectively.  

▪ Make sure that any additional signs specific to the event are 

designed using large print.  

▪ Find a suitable area where service animals can relieve 

themselves.  

▪ Provide water bowls for service animals. 
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Resource C: Sample Data Collection Form – Transit Agencies 

Purpose:  To collect, support, and maintain statistics on the Travel Training Program. 

Use:  Transit agencies can complete this form to track their travel training activities.  This form 

is available in EXCEL format. 

Agency Name: 

Area(s) of Service: 

               

 Trainers Delivering Orientation 
Travel Training 

Orientation Sessions 
Fares Provided for Travel Training  

Out of 
Service 
Vehicle 
Usage 

(past 12 
month 

 

Date Name 

Agency 
delivering 

orientation (if 
not transit 
agency) 

Hours 
Worked 

# of 
Participan

ts 

Community 
Service 

Provider(s) 
in 

attendance 

Type of 
Fare 

# 
Used 

during 
Traini

ng 

# 
Used 
for 

Incent
ives 

Cost 
($) 

# Times 
Used 

# 
Hours 
Used 

                        

                        

                        

                        

                        

                        

                        

                        

                        

Total                        
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Resource D: Sample Data Collection Form – Community Service 

Providers 

Purpose:  To collect, support, and maintain statistics on the Travel Training Program. 

Use:  Community service providers can complete this form to track their travel training 

activities.  It may be used to report back to the supporting transit agency when required.  This 

form is available in EXCEL format. 

    
Travel Training Sessions 

     

 
Travel Trainers 

 

General 
Orientation 

Training 

Personal 
Mobility 
Device 

Training 
Destination 

Training 
General Follow-up Questions 

 

Funding 
Sources 

 

Date Name 

Volunteer 
or 

Employed 
Hours 

Worked  
# of 

Participants 
# of 

Participants 
# of 

Participants 

# 
Participants/ 

Travelling 
independently 

# 
Participants/ 
Specialized 

transit to 
fixed route 

Source 
Name % 
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Additional Information 

The following sources contributed to the development of the Travel 

Training Program: 

Association of Travel Instruction (ATI) www.travelinstruction.org 

CNIB www.cnib.ca 

March of Dimes Canada www.marchofdimes.ca 

Easter Seals Project Action www.projectaction.org  

The Canadian Hearing Society www.chs.ca 

Transit Cooperative Research Program (TCRP) www.TRB.org 

TransLink, Greater Vancouver Transportation Authority 

www.translink.ca 

Transport for London, UK www.tfl.gov.uk 

Washington Metropolitan Area Transit Authority (WMATA) 

www.wmata.com 
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